ClickOnce Visual Studio 2013 Walkthrough

*»**Bug Warning*** As of right now, customers will need to make sure the "target framework" is set to
.NET 4 and not .NET 4.5 if they're using SHA2. See this article for the bug report and workaround: http
s:/lconnect.microsoft.com/VisualStudio/feedbackdetail/view/957188

This is intended to be a walk through for how to properly sign a standard clickonce application. This walk through utilized Windows 8.1 Pro with
Microsoft Visual Studio Ultimate 2013 Version 12.0.21005.1 REL using Micosoft .Net Framework Version 4.5.5.141. This information can be found
in the Help > About Microsoft Visual Studio.

To get started | downloaded and installed Visual Studio 2013 which took about an hour. | also had to download Windows SDK for Windows 8.1,
which contained signtool located in C:\Program Files (x86)\Microsoft SDKs\Windows\v7.1A\Bin\signtool.exe.

I then found a pre-built app with the help from Lynda.com and their exercise files if you are a member. It talks about the clickonce here, even
though he did not sign correctly: http://www.lynda.com/ASPNET-tutorials/Creating-ClickOnce-application/67159/76641-4.html

Here is this wiki as a PDF you can send to customers if you want.

Make sure you update to the lastest version of Safenet!

Once everything is loaded | had to modify the properties of the project. Double click on properties on the right and then click on Application. | did
not change anything here, but wanted to show the settings.
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Then click on Build Events. Build Events are what actually sign the application, to do it properly | specified it as a post-build event.
If using an EV code signing certificate they can use the following command:

"C:\Program Files (x86)\Microsoft SDKs\Windows\v7.1A\Bin\signtool.exe" sign /n "Elvtech Web Solutions, Inc." /v
"$(ProjectDir)obj\x86\$(ConfigurationName)\$(TargetFileName)"

® The double quotes are required.

® “C:Program Files (x86)Microsoft SDKsWindows\v7.0A\bin\signtool.exe” is the path to the signtool application, used to sign the
executable.

® $(ProjectDir) points to the top directory of the project. The subfolder “\obj\x86” will vary depending on your build output path. The
above was created and tested on VS2010. On VS2012, it may just be \obj. Note the path obj - ClickOnce pulls from the obj (not
bin)

® $(ConfigurationName) is the build configuration name, such as Debug or Release — this is required because it signs it in the obj
directory and has to know which folder to use.

® $(TargetFileName) is the name of the application executable.

® You can see the actual output of the variables by clicking on Macros > >. Please note that | just kept the variables in the
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command.
If using a standard code signing certificate they can use the following command:

"C:\Program Files (x86)\Microsoft SDKs\Windows\v7.1A\Bin\signtool.exe" sign /f "$(ProjectDir)KenyonAbbott.pfx" /p test /v
"$(ProjectDir)obj\x86\$(ConfigurationName)\$(TargetFileName)"

® The double quotes are required.

® “C:Program Files (x86)Microsoft SDKsWindows\v7.0A\bin\signtool.exe” is the path to the signtool application, used to sign the
executable.

® $(ProjectDir) points to the top directory of the project. The subfolder “\obj\x86” will vary depending on your build output path. The
above was created and tested on VS2010. On VS2012, it may just be \obj. Note the path obj - ClickOnce pulls from the obj (not
bin)

® $(ConfigurationName) is the build configuration name, such as Debug or Release — this is required because it signs it in the obj

directory and has to know which folder to use.

$(TargetFileName) is the name of the application executable.

KenyonAbbott.pfx is the name of the certificate file, which should be located in the top folder of the project.

Ip test — this is the password for the certificate

You can see the actual output of the variables by clicking on Macros > >. Please note that | just kept the variables in the

command.

| was lucky enough to find this command located on a website, but they were using a PFX file, | modified it to use my EV SHA1 code signing
certificate. | only had one certificate by this name so | was able to specify by subject name. If they have multiple with the same name you will need
to specify a different switch in signtool.
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Then you can go to the Signing tab and check "Sign the ClickOnce mainifests" and then with the EV token plugged in select it from the store by
clicking select from store.
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Then you can click on the Publish tab. This should be already setup by the developer, but you can publish the application to a directory (Publish
Folder Location). Then the installation can be moved to the place the installation will reside, most times a website. This path (Installation Folder
URL) must be correct of the application will not install. Note: mine are different in some of the screenshots because | was signing with different
certificates to test the results.
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| then built my application first and then entered the token password.
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I then clicked publish now to publish the application,

Dd ClickOnceDeploy - Microsoft al Studio G Y5 Quick Launch (Ctr+Q)
FILE EDIT VIEW PROJCT BUILD DEBUG TEAM TOOLS TEST ARCHITECTURE ANALYZE WINDOW  HELP
e - B2 W - <P Start - - Release - ¥ _
' PixelSmithDeskiop & X ~ Solution Explorer X
§ | Application @ o-2odm £
=1 Platform: | N/A
2 Build Search Solution Explorer (Ctrl+;) p
L Build Events Publish Location 1] Solution 'ClickOnceDeploy’ (1 project)
g 4 (6 PixelSmithDesktop
g| Detu Publishing Folder Location (web site, ftp server, or file path) 7l Ohiais
e \\ocalhost\Users\Kenyon\Desktop\deploy\ v b e Assemblyinfo.cs
. 4 [ Resources.resx
ervicss Installation Folder URL (if different than above) b ) Resources Designer.cs
Settings httpi/ /s v b ## Settings settings
Reference Paths b v References
Install Mode and Settings b o Images
Signing o
() The application is available online only Application Files. 3 app.config
Security. b ) Appxaml
® The application is available offline as well (launchable from Start menu) [Em——— 3 ClassDiagram1.cd
4 [ MainWindow.aml
EmiRarTiEs == b ) MainWindow.saml.cs
& PixelSmithDesktop_TemporaryKey.pfx
Options.
Publish Version
Major:  Minor  Build Revision
1 o o 26
Solution Explorer | Team Explorer Class View
Automatically increment revision with each publish
Properties :::: v i x
Publish Wizard. Publish Now -
ERARS
Output v ax
Show output from: Debug - -]

*PixelSmithDesktop.vshost.exe' (CLR v4.8.38319: PixelSmithDesktop.vshost.exe): Loaded 'C:\WINDOWS\Microsoft.Net\assembly\GAC_MSILAUIAUE &

The
The
The
The

.

Error List | Output

thread 8x1504 has exited with code 259 (@x103).

thread @xdle has exited with code 259 (x103).

program [864] PixelSmithDesktop.vshost.exa: Program Trace' has exited with code @ (@x@).
program '[864] PixelSmithDesktop.vshost.exe' has exited with code 8 (8x8).

Enter token password again when prompted.
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Completing the operation you requested..

The end result will open the the Installation Folder URL automatically. | am also showing where the application actually was created here.
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| then actually zipped the contents and moved it to my Installation Folder URL location and unzipped it there resulting in below.
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You can then download the exe file and run it.



Qydigicert
DigiCert Rep - Kenyon
[ http/smnew blackwavemarketing.com/clickonc © « & || [ Msi 1/29/2014 11:59:37 AM

[a3m s
G <sm W Foliow @msn SIGN IN

(4 View Downloads - Windows Internet Explorer

msr

news sports ent

View and track your downloads Search downloads

Hame Lacation Actions

3 setup.exe H5KB  Downloads
Eltech Web Salutions, Inc

Snowbird, UT Options Clear list

alirornia
follow

‘* 300 towns could run

P
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| created a new account when | used the Promo code. Although re-keying may have been the wrong way to do it, the new .pfx file worked. So
here is a writeup about what happened:

Request:

Deploy a digicert signed vsto using clickonce installation and Visual Studio 2013

Procedure:

This procedure is to sign a VSTO directly using an imported certificate which includes a private key (not on a token)
1. Install the Certificate provided by digicert into the certificate store.

2. Configure Visual Studio to sign the published manifests

Under Project Proerties, select "Signing"

Select "Sign the ClickOnce manifests"

Click "Select from Store" or "Select From File"

Select the digicert certificate.

Set the timestamp URL: http://timestamp.digicert.com

3. Save the properties

4. build and publish.

The setup.exe file and vsto manifest will both reference/be signed by the digicert certificate.

This procedure is to resign a file already signed by another certificate

1. Setup the Visual Studio project using a self signed certificate to sign the manifests when publishing.

2. Built the vsto using Visual Studio.

3. Obtain/Export the digicert certificate from the certificate store including the private key. It is important to have the certificate both in the store
and as a .pfx file.

3. Loaded the Windows SDK 7.1 from Microsoft's website.

4. From the "start" menu, select "All Programs->Microsoft Windows SDK 7.1->Windows SDK 7.1 Command Prompt"
5. At the command prompt, navigate to the publish folder.
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http://timestamp.digicert.com

6. At the command prompt, type:

Signtool sign /t http://timestamp.digicert.com /n "<name of the certificate in the store to use>" setup.exe

7. Next, sign the manifest

Mage —sign <name of the manifest>.vsto —CertFile <path to .pfx file> -Password <password of the .pfx file>

The setup.exe file and vsto manifest will both reference/be signed by the digicert certificate.

When installing the VSTO, if the inclusion list for the installation location (MyComputer/Internet/Intranet/etc) is set to AuthenticodeRequired, the
signing procedures above will allow the VSTO to be installed.

Thank you very much for all your help making this work.
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Errors

EV Code signing with SHA2 throws an error of Unknown Publisher.

Resolution: See this article: Unknown Publisher. If issue still persists it is likely because it is SHA2.

The problem seems to have something to do with Visual Studio signing the manifest file with a SHA2 certificate that is on the SafeNet eToken. |
don't know if the root cause is Visual Studio or SafeNet.

The way | got it to work was to publish the application from Visual Studio as normal and then | went back and manually resigned the manifest file.
Here are the steps. ClickOnce-SHA2_error.pdf Make sure the token is plugged in before continuing.

Here is the warning | was getting right after | published form Visual Studio.

Application Install - Security Waming — @
Publisher cannot be verified. ﬁ:’
Are you sure you want to install this application? ot

Name:

ManifestSignTest
From {(Hover over the string below to see the full domain):

EM\Code\DigiCert\ TestsAppsiManifestSignTest\publish

Publisher:

Unknown Publisher

Install | [ Don'tinstal
o While applications can be useful, they can potentially harm your computer. If you do not trust the
source, do not install this software, More Information. ..

Visual Studio SDK comes with a program called mageui.exe (mine was in my C:\Program Files\Microsoft SDKs\Windows\v7.0\Bin directory).
Double click this program to run it and it will look like this:
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https://intra.digicert.com/hive/download/attachments/25363259/ClickOnce-SHA2_error.pdf?version=1&modificationDate=1392757559000&api=v2
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Check the "Sign on save" checkbox and press OK. DO NOT check the "Use default signing certificate".
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Go to the File menu and select Open. Navigate to the folder where the application was published and ope
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Don't make any changes to the manifest. Go to the File menu and select "Save". The Signing Options dialog should pop up. Select "Sign with
stored certificate", make sure you select your signing certificate by clicking on it (it should be highlighted), enter the timestamp URI, and press OK.
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Name —
Descrption it New
Deployment Cptions | | I_I | = |
Update Options
Application Reference Password | |

@ Sign with stored certificate

TimeStamping URI: hitp:/Atimestamp digicert.com|

(S—— -

This file is not signed.

N

v,

The SafeNet password dialog should pop up. Enter your token password and press OK. After the dialog is gone the signing should be complete
and you can just close the mageui.exe program.

( (= ManifestSignTest.application* - Mage (=)@ = )
File Edit Window Help
oA R- | I Close
Manifest Sign Test application |
S, TokenLogon [

geS?:'ipti::n Opt L4UGS IS 164
ons ASS &D&ss01

Update Options &SafeNet. SafeNet Authentication Client N

Application Reference T

Enterthe Token Password.

Token Name: | DigiCert EV SHAZ

Token Password: |

Cument Language: EN
This is an unlicensed copy for evaluation use only.

Saving, please wait...

N

When you run the application you should now see the publisher.



Application Install - Security Waming - @
-—1
Do t to install this application? b
you want to i is application w{’
Name:
ManifestSignTest
From (Hover over the string below to see the full domain):
EN\Code\DigiCert\ TestsApps\ManifestSignTest\publish
Publisher:
I DigiCert, Inc,
Istall | | Don'tinstal
| _ o :
While applications can be useful, they can potentially harm your computer. If you do not trust the
source, do not install this software. More Information...

Instructions- ClickOnce-SHA2_error.pdf

Standard Code signing shows like below (I expected to get a smartscreen filter after clicking install but | didn't)

B0 it Anan. blackwavernarketing, com/clickones © + & || [ mst

Em 43m W Follow @msn SIGN IN
.1 View Downloads - Windows Intemnet Explorer = E b search
: msn\W
d View and track your downloads Search downfoads
news sports  ent options v
i Hame Location Actions

| 1ET
| | setup‘exe 414 KB Downloads R
=
Kenyon Abbott
1]

Application Install - Security Warning A Certificate

3 General | Dekails | Certfication Path
Do you want to install this application? >, —

§ Certificate Information

_— This certificate is intended for the following purpose(s}:

PixelSrithDesktop « Ensures softnare came fram software publsher
+Pratects software from alteration after publcation

From (Hover over the string below to see the full domaink:

waarw blackwavemarketing.com

Publisher: *Refer to the certification authority's statement For detals.
Keryon Abhott

Issued to: Kenyon Abbott
Install Don't Install
Issued by: Digicert SHAZ Assured ID Code Sigring Ca

While applications fram the Intermet can be useful, they can patentially harm your camputer, If
you do nat trust the source, do nat install this software. hore Information.

valid from 10/22/2013 to &14[2014

i Network

Install Certficate...| | Issuer Statement:

Learn mare about certificates

0K

Standard code signing without specifying a post-build event:

Resolution: Make sure a post-build event is specified.


https://intra.digicert.com/hive/download/attachments/25363259/ClickOnce-SHA2_error.pdf?version=1&modificationDate=1392757559000&api=v2

& View Downloads - Windows Internet Explorer

m S n\‘ View and track your downloads Search downloads
Hame Location Actions
news sports ente »ption
setup.exe H14KE  Downlaads
Run
Application Install - Security Warning A Certificate
Do you want ta install this application? 3’, General |Detais | Certfication Path

g Certificate Information

This certificate is intended for the following purpase(s):

« Ensures software came From software publisher
# Protects software from alteration after publication

Name:
PixelSmithDesktop

From (Hover over the string below to see the full domaink:
weww.blackwavernarketing.com

Publisher: * Refer ko the certification authority's statement for details,
Kenyon Sbbatt

Issuedto: Kenyon Abbott
Install Don't Install

Issuedby: DigiCert SHAZ Assured ID Code Signing CA

While applications from the Internet can be useful, they can potentially harm your computer. If
wou do not trust the source, do not install this software, More Information...

R 1
| S JU  ———F

valid from 10/22/2013 to 8/14/2014

Install Certificate... | Issuer Statement

Learn mare about certificates

Windows protected your PC

Windows protected your PC

Running th

Another article on this: Error: EV Code Signing in Visual Studio 2010/2012 + Windows 8 / Smart screen filter won't allow install ClickOnce
deployment


https://intra.digicert.com/hive/pages/viewpage.action?pageId=21333945
https://intra.digicert.com/hive/pages/viewpage.action?pageId=21333945
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